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Introduction 
As a CONNECTIONS user, you are contributing to New York State’s child welfare data 
management system. Timely record keeping and documentation is an essential part of 
maintaining an accurate and reliable database. This guide is meant to provide detailed 
instructions for updating or correcting information contained in CONNECTIONS as soon as 
possible. 

 

The Content of this Guide 
This guide contains step-by-step instructions for accomplishing necessary updates or changes in 
CONNECTIONS, introductory remarks that provide a work context for these tasks, and hints for 
carrying out these tasks efficiently and effectively. 

The last section of this guide contains hands-on practice exercises for you to use with the 
Training Database to reinforce your CONNECTIONS skills. These exercises cover key 
CONNECTIONS activities you perform as a FAD caseworker. 

 

 

 

 

Note: 
Any visible identifying data 
in this guide is simulated. 
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Features of this Guide 
Two features of this guide help you quickly identify the information you need: 

• Tips, set apart in margin boxes, provide information to help you carry out 
CONNECTIONS tasks efficiently and effectively. Icons in the boxes help focus your 
attention on three kinds of tips: 

Bright ideas 

Helpful hints 

Things to watch out for 
 

• Subdivided Instructions: The step-by-step instructions for each procedure are subdivided 
into major sub-steps to make it easier to jump ahead to the correct step if you’re already 
on the window you need to access. After the initial instructions on how to sign on to the 
system and access CONNECTIONS, step-by-step instructions assume you have accessed 
the CONNECTIONS Toolbar.  

We hope you find this to be a useful aid in your FAD work! 
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Using the Training Database with this Guide 
You can use this guide in two ways: as a training tool to develop new skills; and as a resource for 
your daily work in CONNECTIONS. In either case, we suggest that you use this guide while 
working directly in CONNECTIONS Production or in the Training Database. 

What is the Training Database? 
The Training Database provides a safe environment for workers to learn and practice 
CONNECTIONS skills using simulated case data. The SUNY Training Strategies Group acts as 
the custodian for the Training Database sign-on IDs. These ID numbers are referred to as 
Desktop User (DU) numbers and Instructor Led (IL) numbers. Sign-on numbers begin with 
either DU or IL, and are followed by four digits. With a DU number a local district or voluntary 
agency staff member can sign on to the Training Database and practice using CONNECTIONS 
functionality that mirrors the CONNECTIONS Production system. 

The Training Database has the look and feel of the CONNECTIONS system currently in 
production. When you sign on to the Training Database using a DU number, you will see a 
simulated environment displaying the Assigned Workload of a fictitious worker, Darryl Wilson. 
Darryl Wilson has been assigned several stages of service, including Foster and Adoptive Homes 
(FAD stages). These stages have been created specifically for training purposes. In the New 
York City training labs, you will use IL numbers, which display the Assigned Workload for a 
fictitious worker named Jamie Miller. 

When you sign on as Darryl Wilson or Jamie Miller, you have the ability to complete the tasks 
necessary to maintain a FAD home. The Training Database also has common functions, such as 
Person Search, Resource Search and a Staff To-Do List. 

Darryl Wilson also has the ability to access the workload of his supervisor, Sally May. Jamie 
Miller has the ability to access the workload of his supervisor, Cassie Landers. You may approve 
work submitted by Darryl Wilson by opening Sally May’s Staff To-Do List and completing 
related approval tasks. Opening Cassie Landers’ Staff To-Do List and completing the related 
approval tasks approves the work submitted by Jamie Miller. 

Information is deleted when the computer system is refreshed each night; any data you enter into 
the system is available to you only until the end of that day. 
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Lending Procedures for Training Database DU Numbers 
SUNY Training Strategies Group is responsible for lending DU numbers to voluntary agencies 
and local districts. Agencies and districts can use these DU numbers to train new workers and to 
allow experienced workers to practice new skills. 

The procedure for obtaining DU numbers is outlined below: 

• Local districts and voluntary agencies are encouraged to identify one person from each 
agency who is designated to have the authority to request DU numbers. 

• The designated person should call 1-877-451-4835 and ask to borrow DU number(s) for 
a specific period of time. 

• DU numbers can be borrowed for up to three weeks at a time; a maximum of four DU 
numbers may be borrowed per order. 

• The following information is needed at the time of the request: 

◊ Borrower’s name 
◊ Borrower’s agency/facility 
◊ Telephone number 
◊ Start date for use of DU number(s) 
◊ Expiration date 
◊ Purpose of the request 

 
• The caller will be provided by e-mail with the requested number of DUs and a password 

for each DU number assigned. 

• Once you have received DU numbers, follow the directions below to access the 
CONNECTIONS Training Database. 
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Logging On to Your PC 
The CONNECTIONS application can be accessed only by designated individuals on computers 
that are set up to run the application. Some CONNECTIONS computers use the Windows NT 
3.51 operating system, while newer CONNECTIONS computers use Windows 2000. This 
section addresses the procedures for logging on to both of these operating systems. 

Once you have completed logging on to Windows, the step-by-step instructions in the next 
section will show you how to access CONNECTIONS. 

 

 

Step-by-Step: 
Logging On to the Windows NT 3.51 Operating System 

1 Press the Ctrl + Alt + Delete keys on your keyboard at the same time. 
A Confidentiality warning displays. 

2 Click on the OK button in response to the Confidentiality warning. 
The Log On window displays. 

3 Enter your user name in the Username field. 

4 The From field (“domain”) is pre-filled. To change the domain, click on the drop-
down arrow and select from the resulting list. 

5 Tab to the Password field and enter your password. 
This field is case sensitive. 

6 Click on the OK button. 
The Program Manager window displays for your local desktop. 

 

 

Step-by-Step: 
Logging On to the Windows 2000 Operating System 

1 Press the Ctrl + Alt + Delete keys on your keyboard at the same time. 
A Confidentiality warning displays. 

2 Click on the OK button in response to the Confidentiality warning. 
The Log On window displays. Make sure that your user name and domain are listed 
correctly in the log on dialog box.  

3 Enter your password and click on the OK button. 
Your Windows 2000 local desktop displays. 
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Accessing CONNECTIONS 
The CONNECTIONS application is made available to users in three different ways: 

Production Database The Production Database contains “live” data. This is the 
database that all workers use to record information in 
CONNECTIONS. 

Training Database The Training Database contains simulated data and allows you to 
practice functions necessary for your casework activities. It 
mirrors the functionality of the Production Database. 
(See “Using the Training Database with this Guide” on page 3 
for more information.) 

Preview Application The Preview Application contains a “snapshot” of actual case 
data. Information entered into the Preview application does not 
carry over to the Production database. 
The Preview Application provides the opportunity to preview 
changes and enhancements planned for the CONNECTIONS 
system. The Preview Application is available for a limited time 
when changes to the system are made. You will receive special 
notice when the Preview application becomes available. 
 

You cannot have more than one of these applications open at the same time. 

To distinguish between the Training Database and the Preview Application, keep in mind that 
the Training Database contains simulated data, while the Preview Application is a “snapshot” of 
actual case data. The Training Database allows you to practice functions necessary for your 
casework activities. Information entered into the Preview Application does not carry over to the 
Production database. 

Using the CONNECTIONS Production database, you can access your Assigned Workload from 
any CONNECTIONS workstation throughout New York State. All you need is a valid User ID 
and password to gain access to your workload. 

 
If the AutoComplete window displays during the logon process, 

select the Don’t offer to remember any more passwords 
check box and click on the No button. 
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Step-by-Step: 
Launching CONNECTIONS (Production) 

1 Double-click the Logon to Connections Production 
icon. 
A Microsoft Internet Explorer window displays 
containing the Logon dialog box for Citrix. 

2 Enter your User Name in the Username field. 
This field is pre-filled with information entered by 
the last person who used this computer. 

3 Enter your password in the Password field. 
This field is case sensitive. 

4 Enter the appropriate domain in the Domain field. 
This field is pre-filled with information entered by 
the last person who used this computer. 

5 Click on the Logon button. 
A File Download Progress box displays, followed by 
a Confidentiality Warning message box. 

6 Click on the OK button. 
The Citrix desktop displays and your Citrix session 
begins. 

This Citrix desktop covers your local desktop and remains open 
for the length of your Citrix session. Citrix uses Windows 2000; 
if your PC runs Windows NT 3.51, the Citrix desktop looks 
quite different from your local desktop. The Citrix desktop also 
has an easily recognizable background. 

On the Citrix desktop, program icons appear directly on the 
desktop, rather than in Program Group windows (as on your 
local desktop, if your computer runs Windows NT 3.51). 
Double-clicking an icon starts the application represented by 
that icon, opening a window on your desktop for that 
application. 

The Task Bar at the bottom of the Citrix desktop provides a method of organizing the 
application windows that you have open in Citrix. You can have more than one window open on 
your desktop at a time. Minimize a window by clicking on the Minimize button ( ). The 
minimized window displays as a button on the Task Bar. This makes room for other windows 
you need to use at that moment. To re-open an application, click on its button on the Task Bar; 
the application displays as the active window, placing it “on top of” any other open windows. 

 
If your CONNECTIONS 

computer runs the Windows NT 
3.51 operating system, replace 
Step 1 at left with these steps: 

1 Double-click the 
CONNECTIONS Logon icon 
in the Windows Program 
Manager. 
The CONNECTIONS Logon 
Program Group displays. 

1a Double-click the Logon for 
CONNECTIONS Production 
icon. 
A Microsoft Internet 
Explorer window displays, 
containing the Logon dialog 
box for Citrix. 

 
If you incorrectly enter your 

password, the following 
message displays: 

“There was an error generating 
your application list: the Citrix 

Server reported that the 
Credentials entered were 

incorrect.” 

Re-enter your password and 
click on the Logon button. 
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Clicking on the Start button (in the lower left corner of the 
Citrix desktop) displays the Start menu, which provides access 
to the Citrix Log Off procedure. (See page 11 for details about 
this procedure.) 

Within Citrix, the Windows 2000 system consisting of desktop 
icons, the Start menu and the Task Bar, replaces the Program 
Manager and Program Group system of program management 
found on CONNECTIONS PCs using Windows NT 3.51. 

When you log on to Citrix via the CONNECTIONS Production Database icon on the local 
desktop, three icons display on the Citrix desktop: 

• CONNECTIONS Production 
• CIN/PID (Data Warehouse; limited to designated users) 
• Policy Library 

 
Double-clicking an icon opens its corresponding application. 

 

 

Step-by-Step: 
Launching CONNECTIONS (Training Database) 

1 Double-click the Logon to Connections 
Training/Preview icon. 
The Citrix Logon dialog box displays in Microsoft 
Internet Explorer. 

2 Enter a training user name (DU or IL#) in the 
Username field. 
This field is pre-filled with information entered by 
the last person who used this computer. 

3 Enter the same training user name (DU or IL#) in 
ALL CAPS in the Password field. 
This field is case sensitive. 

4 Enter the appropriate domain in the Domain field. 
This field is pre-filled with information entered by 
the last person who used this computer. If you are 
unable to logon using the NYSDSSNYC domain, 
enter NYSDSSALB in the Domain field. 

5 Click on the Logon button. 
A File Download Progress box displays, followed by a Confidentiality Warning 
message box. 

 
Windows NT 3.51 PCs display 
scroll bars on the bottom and 
right side of the screen; these 
scroll bars allow you to access 

the small portions of the desktop 
not visible when the Citrix 

desktop first opens. 

 
If your CONNECTIONS 

computer runs the Windows NT 
3.51 operating system, replace 
Step 1 at left with these steps: 

1 Double-click the 
CONNECTIONS Logon 
icon in the Windows 
Program Manager. 
The CONNECTIONS Logon 
Program Group displays. 

1a Double-click the Logon for 
CONNECTIONS 
Training/Preview icon. 
A Microsoft Internet 
Explorer window displays, 
containing the Logon dialog 
box for Citrix. 
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6 Click on the OK button in response to the confidentiality warning message. 
The Citrix desktop displays and your Citrix session begins. (For detailed information 
about Citrix, see page 7.) When you sign on using the Logon for CONNECTIONS 
Training/Preview icon, three icons display on the Citrix desktop: 

• CONNECTIONS Training 
• CONNECTIONS Preview 
• Policy Library 

7 Double-click the CONNECTIONS Training icon 
on the Citrix desktop. 
When the CONNECTIONS Training Database has 
launched successfully, the CONNECTIONS Toolbar 
displays. In the title bar, the DU number you entered 
displays as the fictional caseworker Darryl Wilson 
with the same ending digits, not counting zeroes 
(e.g., DU0123 displays as Wilson123,Darryl). If you 
entered an IL number, the title bar displays the 
name of the fictional caseworker Jamie Miller. 

 

 

Step-by-Step: 
Launching CONNECTIONS (Preview Application) 

1 Double-click the Logon to Connections 
Training/Preview icon. 
The Citrix Logon dialog box displays in Microsoft 
Internet Explorer. 

2 Enter your user name in the Username field. 
This field is pre-filled with information entered by 
the last person who used this computer. 

3 Enter your password in the Password field. 
This field is case sensitive. 

4 Enter NYSDSSNYC in the Domain field. 
This field is pre-filled with information entered by 
the last person who used this computer. If you are 
unable to logon using this domain, enter 
NYSDSSALB in the Domain field. 

5 Click on the Logon button. 
A File Download Progress box displays, followed by 
a Confidentiality Warning message box. 

 
If you incorrectly enter your 

password, the following 
message displays: 

“There was an error 
generating your application 

list: the Citrix Server reported 
that the Credentials entered 

were incorrect.” 

Re-enter your password and 
click on the Logon button. 

 
If your CONNECTIONS 

computer runs the Windows NT 
3.51 operating system, replace 
Step 1 at left with these steps: 

1 Double-click the 
CONNECTIONS Logon 
icon in the Windows 
Program Manager. 
The CONNECTIONS Logon 
Program Group displays. 

1a Double-click the Logon for 
CONNECTIONS 
Training/Preview icon. 
A Microsoft Internet 
Explorer window displays, 
containing the Logon dialog 
box for Citrix. 
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6 Click on the OK button in response to the 
confidentiality warning message. 
The Citrix desktop displays and your Citrix session 
begins. (For detailed information about Citrix, see 
page 7.) When you sign on using the Logon for 
CONNECTIONS Training/Preview icon, three 
icons display on the Citrix desktop: 

• CONNECTIONS Training 
• CONNECTIONS Preview 
• Policy Library 

 
7 Double-click the CONNECTIONS Preview icon on 

the Citrix desktop. 
When the CONNECTIONS Preview Application has launched successfully, the 
CONNECTIONS Toolbar displays. The title bar reads, “CONNECTIONS Preview - 
<Your Name>.” 

 
If you incorrectly enter your 

password, the following 
message displays: 

“There was an error 
generating your application 

list: the Citrix Server reported 
that the Credentials entered 

were incorrect.” 

Re-enter your password and 
click on the Logon button. 
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Closing CONNECTIONS and Logging Off Your PC 
When you have finished your work in CONNECTIONS, you should close both 
CONNECTIONS and your Citrix session. This is best done as a two-step process: first close 
CONNECTIONS, then log off of Citrix. Doing so (as opposed to logging off of Citrix while 
CONNECTIONS is still open) reduces the likelihood of problems occurring during the log off 
procedure. 

At the end of your work day, it is important to log off your PC; if you completely shut down 
(turn off) your computer, it will not be able to receive any updates that may occur overnight. 
Leaving the computer logged off (but with the power still on) will enable it to receive these 
updates. 

The step-by-step instructions below will assist you in closing CONNECTIONS and logging off 
of your PC. 

 
 

 

Step-by-Step: 
Closing CONNECTIONS and Logging Off Your PC 

1 Clicking on the File menu (represented by the Globe icon [ ] in the upper left 
corner of the CONNECTIONS Toolbar) and select Close. 
 
—OR— 
 
Click on the Close button ( ) in the upper right corner of the CONNECTIONS 
Toolbar. 
You may need to use the vertical scroll bar to scroll up on the desktop to reveal the 
Globe icon (File menu) on the CONNECTIONS Toolbar. 

2 Click on the Start button in the lower left corner of the Citrix desktop and select Log 
Off <User name> from the resulting menu. 
The Log Off dialog box displays. 

3 Click on the Yes button. 
This does not log off your machine; it only ends your session with the Citrix server. 
Your local desktop displays. 

4 Close all applications still open on your local desktop. 
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5 Click on the Start button. 
The Start menu displays. 

6 Click on the Log off <user name> command. 
The Shutdown Windows dialog box displays. If 
necessary, click on the drop-down arrow and select 
Log off <user name>. 

7 Click on the OK button. 

 

 

 

 

 

 
If your CONNECTIONS 

computer runs the Windows NT 
3.51 operating system, replace 

Steps 5-7 at left with these 
steps: 

1 Click on the File menu and 
select Shutdown.  
The Shutdown Computer 
dialog box displays. 

2 Click on Log off <user 
name>. 

3 Click on the OK button. 
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CONNECTIONS Security 
In order to protect the confidentiality and integrity of case data, 
access to information in CONNECTIONS is carefully 
controlled. A number of factors determine the information a 
worker can view or maintain in CONNECTIONS, including the 
worker’s job function, the cases to which the worker is assigned 
and the worker’s Business Function Profile (BFP). 

All CONNECTIONS users receive security profiles which 
determine the windows or types of information they can open 
and view, as well as which windows they can modify or 
“maintain.” In CONNECTIONS, each person’s security profile 
is called a Business Function Profile (BFP). Each worker has 
only one BFP. Each BFP is comprised of one or more Business 
Functions. Your BFP is based on the tasks you are responsible 
for performing and the level of access to records needed to complete those tasks. Your BFP may 
multiple business functions based on your responsibilities. 

Security coordinators at the local district and voluntary agency level assign appropriate Business 
Functions to each staff person in their offices, creating an individual Business Function Profile 
for each worker. An example of a Business Function that might be included in a FAD 
caseworker’s BFP is MAINT FAD (Maintain FAD). Workers with the UNIT SUM ACCESS 
Business Function in their respective BFPs are able to review the Assigned Workloads of the 
staff members in their units. (Typically, this Business Function would be included in the BFP of 
a Unit Approver.) 

If you are working on a stage and cannot view or modify information that relates to your job 
responsibilities, you should review your BFP with your supervisor to make sure the Business 
Functions included in your BFP are adequate for the work you are doing. 

A special Business Function, VIEW SECURITY, allows you to review your BFP in 
CONNECTIONS to see the Business Functions assigned to you. If your BFP indicates that you 
do not have security access for a task you need to complete, speak with your supervisor and your 
office’s security coordinator. 
 

 

Step-by-Step: 
Viewing Your Business Function Profile 

1 Click on the Options menu on the CONNECTIONS Toolbar and select Security. 
The Security sub-menu displays. 

2 Click on the View Staff Security command. 
The Staff Search Criteria window displays. 

3 Type your first and last names into the appropriate fields. 

 

What you are able to view and 
the tasks you are able to 
perform in the Training 

Database may not mirror what 
you are able to do in the 

Production Database. Contact 
your security coordinator if you 
have questions regarding your 

security access. 
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4 Click on the Search button. 
The Staff List displays. 

5 Click on your name to select it from the Staff List. 

6 Click on the OK button. 
The Staff Security window displays. The Business Function list box in this window 
contains the Business Functions that have been assigned to you. 

7 The Business Functions assigned to you are identified with red check marks. Use the 
vertical scroll bar inside the Business Function list box to view the entire list. 

8 To close the Staff Security window, click on the Cancel button. 
The Staff List displays. 

9 To close the Staff List, click on the Close button. 
The Staff Search Criteria window displays. 

10 To close the Staff Search Criteria window, click on the Close button. 
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Module 1: 
Maintaining Home Demographics 

The Home Demographics window is used by FAD workers to record, maintain and view 
demographic information about a FAD home. 

By the end of this module you will be able to: 

• maintain home address phone and name information; 

• update person detail information;  

• remove persons from a FAD stage; 

• merge and split person records; 

• access and view the Historical Person List; 

• describe how certificates and letters are handled in the CONNECTIONS system; and 

• maintain Program Types and program authorization dates for FAD homes. 
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The Home Demographics Window 
The Home Demographics window is used by FAD workers to record, maintain and view 
demographic information about a FAD home. The title bar displays the Home Name, Resource 
ID and Case ID when the window is opened in View-only or Modify mode (when the window is 
opened in New mode, “New” displays next to the window name in the title bar). 

Fields 
All of the fields in the Home Demographics window are modifiable except the following: 
Status, Home Name, Setting, Auth. Agency and Sub Agency. These fields are connected to the 
FAD license and are therefore modifiable only through the F/A Home License window, rather 
than the Home Demographics window. The information is carried over by the CONNECTIONS 
system from the F/A Home License window to the Home Demographics window. 

For most FAD homes, the Resource (Home) Name is the same as its Legal Name. Sometimes the 
Legal Name of a FAD Home is different than the Resource Name in the database. The Legal 
Name field allows workers to record a Legal Name that is different from the Resource Name. If 
the two names are the same, the system defaults the Legal Name to the data in the Home Name 
field when the home is Saved and Assigned. 

The Race field contains a list of races and sub-groups that can be recorded in CONNECTIONS. 
More than one race may be selected from the list. The Ethnicity field contains two options, 
Hispanic or Latino and Non-Hispanic or Latino. The Hispanic or Latino Origin field 
contains a list of origins that can be recorded in CONNECTIONS. Multiple origins may be 
selected. To select an origin, double-click its corresponding check box. A red check mark will 
display, indicating the selection. To de-select an origin, double-click the red check mark. 

Buttons 
All Primary Addresses entered for FAD homes need to be validated using the Validate button. 
The Validate button performs CODE-1 validation for addresses to make sure that they comply 
with the US Postal Service address formatting standards. (The Validate button is disabled until 
address information is entered.) 

The Address… and Phone… buttons allow workers to record other addresses and phone 
numbers that may not be the primary information but are still relevant to the home. For example, 
a business address or school address may be recorded. The Primary Address and Phone should 
be recorded directly in the appropriate fields on the Home Demographics window. 

The Save & Assign button enables only when a new home is being recorded on the Home 
Demographics window. For updating or correcting information about an existing home, the Save 
& Assign button is disabled. 

The Save button saves any changes that have been made to the window and returns the worker to 
the Task List for the selected stage. 

The Cancel button cancels all changes made to the Home Demographics window since the last 
save. The Cancel button is disabled until changes are made to the window. Once this button is 
clicked, it disables until the next time changes are made to the window. 
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Step-by-Step: 
Modifying Information on the Home Demographics Window 

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Select the FAD stage you would like to view/update. 
The Tasks… button enables. 

3 Click on the Tasks… button 
The Task List displays. 

4 Click on the Maintain Non-Licensing Information task. 
5 Click on the Detail… button. 

The Home Demographics window displays. 
6 Click on the Legal Name field and record a legal 

name. 
7 Click on the drop-down arrow for the Ethnicity 

field and select Hispanic or Latino from the 
resulting list. 

8 Double-click the check box(es) in the Hispanic 
or Latino Origin list box to select one or more 
origins. 
A red check mark displays, indicating the selection(s). 

9 Click on the drop-down arrow for the Religion field and select from the resulting 
list to change the religion. 

10 Click on the drop-down arrow for the Language field and select from the 
resulting list to change the language. 

11 Click on the drop-down arrow for the Marital field and select from the resulting 
list to change the marital status. 

12 Click on the Save button. 
The Task List displays. 

13 Click on the Close button. 
The Assigned Workload displays. 

 

Resource Address and Phone Information 
When a home’s primary or business address is changed and 
submitted for supervisory approval, CONNECTIONS sends an 
Alert To-Do to the primary worker’s Staff To-Do List. The text 
of the To-Do reads: “Update Home Study/Reauthorization RE: 
Address/Name change.” 

Supervisory approval is required when changing the Home Name, Primary Address or Business 
Address for a FAD home that is in Accepted-Active or Emergency status. If the worker attempts 

 
If more than one language is 
spoken in the home, select 

“Multiple” in the 
Language field. 

 
The Primary Address can only 

be changed on the Home 
Demographics window. 
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to save such changes under these circumstances by clicking on the Save button, the following 
message displays: “Supervisor approval is required for this action. Select Save and Submit.” 

Saving and Submitting generates a Task To-Do for the approver, who navigates directly from the 
Task To-Do to the Resource Address Detail window. An approval event also generates on the 
Event List whenever the Home Demographics window is Saved and Submitted. 

If the pending approval is rejected, the home event status changes to “REJT.” A Task To-Do is 
sent to the worker to make the necessary changes and he/she may navigate directly from the Task 
To-Do to complete the required work. When a primary and/or business address has been 
approved, the primary address of every person in the home is updated automatically to match the 
primary address of the home. If the supervisor rejects an address change, the home’s original 
address information will be restored to the last approved address. 

If a worker navigates to the Home Demographics window when a Home License or Home 
Closure pending approval event exists, the following message displays: 

“Saving will invalidate the pending approval. Continue in modify mode?” 

• Clicking on the Yes button opens the window in Modify mode. If the worker changes any 
of the information on the window and saves the changes, the pending approval event is 
invalidated and the worker must resubmit the approval item to the supervisor. 

• Clicking on the No button opens the window in view-only mode. 

 

 

Step-by-Step: 
Modifying Resource Address Information 

1 Click on the WORK button on the 
CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Select the FAD stage you would like to 
view/update. 
The Tasks… button enables. 

3 Click on the Tasks… button 
The Task List displays. 

4 Click on the Maintain Non-Licensing 
Information task. 

5 Click on the Detail… button. 
The Home Demographics window displays. 

6 Click on the Options menu and select the Address/List Detail… command. 
The Resource Address Detail window displays. 

7 Click on the address in the upper grid that is to be modified. 
8 Enter the new information in the Address Information fields. 

Type directly in the fields (except for the Type, State and County fields, which 

 
If the Business Address is the 
same as the Primary Address, 

be sure to select the 
Use as Business checkbox. 
This functionality ensures that 

valid address information is 
transmitted to BICS for payment 

purposes and is connected to 
system-generated certificates 

and letters. 
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contain drop-down arrows; in these fields, click on the drop-down arrow and 
select from the resulting list). 

9 Click on the Validate button. 
The following message displays: “Replace with CODE-1 Validation Address?” 

10 Click on the Yes button. 
11 Click on the Modify button. 

The window refreshes with the updated information. 
12 To change another address, click on it in the upper grid to select it, then repeat 

Steps 8-11. 
13 To record a new address, click on the Clear button. 

The required fields highlight in yellow. 
14 Record information in the Type and Address fields. 
15 Click on the Add button. 

The window refreshes with the new address listed. 
16 When modifications are complete, click on the OK button. 

The Home Demographics window displays. 
17 Click on the Save button. 

The Task List displays. If the home is in Emergency or Accepted-Active status, 
supervisory approval is required, so the worker must select Save & Submit. 

18 Click on the Close button. 
The Assigned Workload displays. 

 

The Resource Phone Detail window enables workers to record, maintain and view phone number 
information for a FAD home. The Primary phone number is recorded directly on the Home 
Demographics window. The Resource Phone Detail window is used only for recording 
additional phone numbers for the FAD home. The Primary phone number is modifiable only on 
the Home Demographics window; it is protected on the Resource Phone Detail window.  

 

 

Step-by-Step: 
Modifying Resource Phone Information 

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Select the FAD stage you would like to view/update. 
The Tasks… button enables. 

3 Click on the Tasks… button. 
The Task List displays. 

4 Click on Maintain Non-Licensing Information task. 
5 Click on the Detail… button. 

The Home Demographics window displays. 
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6 Click on the Options menu on the Home Demographics window and select the 
Phone/List Detail…command. 
The Resource Phone Detail window displays. 

7 Click on the phone number in the upper grid that is to be modified. 
8 Click on the drop-down arrow for the Phone Type field and select from the 

resulting list. 
9 Enter the phone number in the Number field. 
10 Click on the Modify button. 

The window refreshes with the updated information. 
11 Click on another phone number in the upper grid to modify other phone numbers, 

then repeat Steps 7-8. 
12 To record a new phone number, click on the Clear button and repeat Steps 8-9. 

The Add button enables. 
13 Click on the Add button. 

The window refreshes with the new phone number listed. 
14 When modifications are complete, click on the OK button. 

The Home Demographics window displays. 
15 Click on the Save button. 

The Task List displays. 
16 Click on the Close button. 

The Assigned Workload displays. 
 

Person Detail 
Workers use the Person Detail window to view, update or add information about individuals in 
FAD homes. It enables workers to add principals to the CONNECTIONS database or relate 
individuals already in the database to a FAD home. 

The Person Detail window contains three sections. The top section contains the person’s Name, 
Type, Role and Rel/Int (Relationship/Interest) information. It also indicates the current status of 
the home.  

The middle section of the window contains the following fields and check boxes: 

Sex  Language  Ethnicity Race 

Marital Religion Hispanic or Latino Origin Age 

DOB Approx DOB DOD Approx DOD 

 

The bottom section of the window contains the address and phone information for the selected 
person. 
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Fields 
All of the fields on the Person Detail window are modifiable except the Name fields. The name 
of an individual can be changed only on the A.K.A Name List/Detail window. On the Person 
Detail window, CONNECTIONS records the name automatically. 

The Type field on the Person Detail window defaults to PRN (principal) for all new persons 
added or related to a FAD home. 

All fields highlighted in yellow are required and must be filled in before the Save button will 
enable. 

One principal in the FAD home must be identified with a code of “Foster Parent” in the Rel/Int 
(Relationship/Interest) field on the Person Detail window. If a foster parent is not identified, the 
following message displays when the worker tries to Save and Submit the F/A Home License 
window for approval: “The home must have at least one foster parent identified.”  

The Race field contains a list of races and sub-groups that can be recorded in CONNECTIONS. 
More than one race may be selected from the list. The Ethnicity field contains two options, 
Hispanic or Latino and Non-Hispanic or Latino. The Hispanic or Latino Origin field 
contains a list of origins that can be recorded in CONNECTIONS. Multiple origins may be 
selected. An origin is selected by double-clicking the corresponding check box. A red check 
mark will display, indicating the selection. To deselect an origin, double-click the red check 
mark. The Race and Ethnicity fields allow for more accurate demographic recording and 
reporting. 

Buttons 
All Primary Addresses recorded for FAD homes need to be validated using the Validate button. 
The Validate button performs CODE-1 validation for addresses to make sure that they comply 
with US Postal Service address formatting standards; this button is disabled until address 
information is entered. 

The Address… and Phone… buttons allow workers to record other addresses and phone 
numbers that may not be the primary information but are still relevant to the person. For 
example, a business address or school address may be recorded. The Primary Address and Phone 
should be entered directly in the appropriate fields on the Person Detail window. 

The Save button saves any changes that have been made to the window and returns the worker to 
the Task List for the stage selected. 

The Cancel button cancels all changes made to the Person Detail window since the last save. 
This button is disabled until changes are made to the window. Once the button has been clicked, 
it disables until the next time changes are made to the window. 

If you want to see person detail information about an individual for a particular date, enter the 
date in the Effective Date field and click on the Search button. The fields will populate with the 
person information that was effective on that date. Click on the Reset button to bring back the 
current information. 
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Step-by-Step: 
Modifying Person Detail Information 

1 Click on the WORK button on the CONNECTIONS Toolbar. 
2 Select the FAD stage containing the person whose information you would like to 

view/update. 
3 Click on the Tasks… button. 

The Task List displays. 
4 Click on Maintain Person task to select it, then click on the List… button. 

The Person List displays. 
5 From the Person List, select the person whose information you want to modify. 
6 Click on the Detail… button. 

The Person Detail window displays. 
7 Click in the appropriate fields and change the information that needs to be 

modified. 
8 Click on the Close button. 

The Person List displays. 
9 Click on the Close button. 

The Task List displays. 
10 Click on the Close button. 

The Assigned Workload displays. 
 

 

Step-by-Step: 
Changing a Person’s Name 

1 Click on the WORK button. 
The Assigned Workload displays. 

2 Select the FAD stage containing the person whose name is to be changed. 
3 Click on the Tasks… button. 

The Task List displays. 
4 Select the Maintain Person task and click on the List… button. 

The Person List displays. 
5 Click on the person whose name is to be changed. 
6 Click on the Options menu and select the A.K.A Name List/Detail… command. 

The A.K.A. Name List/Detail window displays. 
7 To invalidate a name, select it from the upper grid and click on the Invalid check 

box. 
8 Click on the Modify button. 

The window refreshes with a red check mark in the INV column and an end-date. 
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9 To record a new name, clear the fields by clicking on the Clear button. 
10 Enter the new name information in the Name Information fields. 
11 If this is a new primary name, click on the Primary Name check box. 

The system will end-date the old primary name and display a red “P” in the 
Primary Name column for the new primary name. 

12 Click on the Add button. 
The window refreshes with the newest information. 

13 Click on the Save button. 
The Person List displays. 

14 Click on the Close button. 
The Task List displays. 

 

Changing a FAD Home Name 
Foster Home names are in the name of the primary caretaker 
(usually the mother). Because of this, it is necessary to change 
the primary caretaker’s name before you can change the home 
name. An example of when a FAD home name may need to 
change is if the foster parent marries or changes his/her last 
name. 

The Home Name field is protected and defaulted on the Home 
Demographics window for all FAD homes. The field is also 
protected when maintaining an existing home. Information in 
protected fields cannot be changed on this window. Protecting 
this field supports the preservation of system data integrity. Due to this functionality, the entire 
foster home name should be entered in the Home Name field when conducting the F/A Home 
Search. 

Supervisory approval is required when changing the Home Name of a FAD home that is in 
Accepted-Active or Emergency status. If the worker attempts to save such changes under these 
circumstances by clicking on the Save button, the following message displays: “Supervisor 
approval is required for this action. Select Save and Submit.” 

Saving and Submitting generates a Task To-Do for the approver. An approval event also 
generates on the Event List whenever the Home Demographics window is Saved and Submitted. 

 

Step-by-Step: 
Changing a FAD Home Name 

1 Click on the WORK button. 
The Assigned Workload displays. 

2 Select the FAD stage whose name is to be changed.  
3 Click on the Options menu and select Case (Stage) Name/CD. 

The Case (Stage) Name/CD window displays. 

 
You must change or record the 
new name on the A.K.A. Name 
List/Detail window before you 
can change the Home Name. 

You must select from the list of 
names using the drop-down 

arrow in the New Name field; 
you cannot type directly 

in the field. 
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4 Click on the drop-down arrow for the New Name field and select the appropriate new 
Home Name from the list of primary names associated with the FAD stage. 

5 Click on the File menu and select Save & Submit. 
The following message displays: 
“This change will also update the Resource Legal Name.” 

6 Click on the OK button. 
The To-Do Detail window displays. 

7 Click on the Save button. 
The Assigned Workload displays. 

 

Removing a Person from a FAD Stage 
There are times when a person may need to be removed from the FAD home in 
CONNECTIONS. Two functions exist in CONNECTIONS to accomplish this task: Remove 
Person – Left Home and Remove Person – Added in Error. These functions are listed in the 
Options menu on the Person List. It is important for FAD workers to utilize this function, since 
it preserves an accurate history of the FAD home and of the individual in CONNECTIONS. 

The Remove Person – Left Home function removes an individual from a FAD home, but keeps 
the person’s record in the database and preserves an historical record of that individual in the 
home. The Remove Person – Added in Error function removes an individual from the home, 
but does not provide an historical record of the individual’s involvement with the home. 
Individuals who are removed via the Remove Person – Added in Error function are purged 
from the database after 90 days if they are not associated with any other cases. 
 

Remove Person – Left Home 
The Remove Person – Left Home function enables a worker to record that an individual has left 
a FAD home (by removing that individual from the Person List), while preserving the historical 
record of that person in the FAD home. Home history reports and historical foster home 
certificates will include individuals who were at some point living in the FAD home, as 
applicable. 

 

Step-by-Step: 
Remove Person – Left Home 

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Click on the FAD stage associated with the person who is to be removed. 
The Tasks… button enables. 

3 Click on the Tasks… button. 
The Task List displays. 

4 Click on the Maintain Person task and click on the List… button. 
The Person List displays. 



 

CONNECTIONS Step-by-Step Guide: Page 25 
Data Maintenance for FAD Caseworkers  (B16-rev 11/18/2003) 

5 Click on the name of the person to be removed from the home. 
6 Click on the Options menu and select the Remove Person – Left Home 

command.  
The following message displays:  
“Are you sure you want to Remove Person – Left Home?” 

7 Click on the Yes button to remove the person from the FAD stage. 
Click on the No button to cancel the Remove Person – Left Home function. 
If Yes was selected, the Person List refreshes with the person’s name removed. 

8 Click on the Close button. 
The Task List displays. 

9 Click on the Close button. 
The Assigned Workload displays. 

 

Remove Person – Added in Error 
The Remove Person – Added in Error function enables a worker to remove an individual who 
was added or related to a FAD home/stage in error. When the worker completes the Remove 
Person – Added in Error function, the misrelated person is removed from the FAD home/stage 
and the individual does not retain an historical association with the FAD home. A Remove 
Person – Added in Error event is created and includes an event description indicating the 
Person ID (PID) that was removed from the stage: “<PID> was removed from stage.” 

The following Alert To-Do also is generated to all workers who are assigned to an open stage 
involving the removed person:  

“<Name> (<PID>) was removed from <Stage Name> (<Stage ID>).” 

In order to perform this function, the worker’s BFP must include the “REM PER ADD ERR” 
Business Function. In addition, the worker must: 

• have an assigned role in the FAD stage; or 

• be in the primary worker’s unit hierarchy. 

In order to maintain accurate data for the person, the worker is responsible for making necessary 
demographic changes prior to performing the Remove Person – Added in Error function. If 
changes have been made to person information since the person was related, the following 
message displays: “Changes made to person in this stage should be reset before continuing.” 

For example, if the person’s age information was changed from 45 to 35 years after being added 
to the stage, the age must be corrected to reflect the original information before the individual 
can be removed from the stage. 

If no changes have been made or if demographic information has been reset or if the person was 
added (not related) to the stage, the following message displays:  

“Are you sure you want to Remove Person – Added in Error?” 
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Step-by-Step: 
Remove Person – Added in Error 

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Click on the FAD stage associated with the person who is to be removed. 
The Tasks… button enables. 

3 Click on the Tasks… button. 
The Task List displays. 

4 Click on the Maintain Person task, then click on the List… button. 
The Person List displays. 

5 Click on the name of the person to be removed from the home. 
6 Click on the Options menu and select Remove Person – Added in Error. 

The following message displays:  
“Are you sure you want to Remove Person – Added in Error?” 

7 Click on the Yes button to remove the person from the FAD stage. 
Click on the No button to cancel the Remove Person – Added in Error function. 
 If Yes was selected, the Person List refreshes with the person’s name removed. 

8 Click on the Close button. 
The Task List displays. 

9 Click on the Close button. 
The Assigned Workload displays. 

 

Person Merge and Person Split Functions 
In your work with CONNECTIONS, you may encounter 
multiple records for the same person, or records for two 
separate persons that have been accidentally combined into one. 

Duplicate records can be created if a worker misses a potential 
match during a Person Search; the worker adds the new person 
record, rather than relating an existing person record in the 
system. The opposite situation—accidentally combined 
records—can result if a worker merges records for two 
individuals who seem to be the same person, but actually are 
not. 

In order to maintain data integrity and prevent problems with accurate case management, 
duplicate and accidentally combined person records are corrected in CONNECTIONS with the 
Person Merge and Person Split functions. A Person Merge joins two separate Person IDs into 
the same record; a Person Split separates person records that were merged in error. 

The M/S column on the Person List indicates that a person has been involved in a merge or split. 

 
The individual responsible for 

merging and splitting is subject 
to local agency policy and 

procedure. This task may not 
fall under the scope of the 

individual caseworker’s 
responsibilities. 

A specific Business Function 
(“MERGE/SPLIT”) is required to 

perform a merge or split. 



 

CONNECTIONS Step-by-Step Guide: Page 27 
Data Maintenance for FAD Caseworkers  (B16-rev 11/18/2003) 

Person Merge 
Once a person merge is completed, the Person Forward (the person who is carried forward to 
further stages) replaces the Person Closed (the person who is merged) in all non-Intake stages 
(open and closed) and events. 

The Person Forward Selection window enables workers to select specific person information to 
be applied to the Person Forward.  

Clicking on the Merge button on the Person/Merge Split window opens the Person Forward 
Selection window. 

The following information displays on the Person Forward Selection window for both the 
Person Forward and the Person Closed:  

• Primary Name • Race • DOD (including reason and 
Approximate indicator) 

• Sex • Marital Status • Primary Address 

• Ethnicity • DOB (including 
Approximate Indicator)

• Primary Phone 

 

Information can be selected from either person by clicking on the corresponding radio button. 
The information retained for the Person Forward is determined by the type of information 
selected and the person from whom that information is selected. 

• If a worker selects information (e.g., Name) from the Person Forward, the primary 
information for the Person Closed is end-dated and copied to the Person Forward. 

• If the worker selects information from the Person Closed, the primary information for 
the Person Forward is end-dated and the information from the Person Closed is 
copied as the primary record. 

Some information is not part of the selection process on the Person Forward Selection window. 
For example, information regarding a person’s Occupation and Living Arrangement is no longer 
recorded. When a Person Merge is complete, the Person Forward’s information is retained for 
Occupation and Living Arrangement. This information also displays in the Person Data Report. 

Valid Person Identifiers, Person Detail FA Home, Language and Religion information also 
are retained from the Person Forward, unless the field is blank. If the Person Forward does not 
have this information recorded, the information from the Person Closed is copied to the Person 
Forward. 
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Step-by-Step: 
Merging Person Records 

1 From the Assigned Workload, select the stage 
containing the person information that requires 
merging. 
The Tasks… button enables. 

2 Click on the Tasks… button. 
The Task List displays for the selected stage. 

3 Click on the Maintain Person task. 
The List… button enables. 

4 Click on the List… button. 
The Person List displays. 

5 Click on the name of the person to be merged. 
6 Click on the Options menu and select Person 

Merge/Split. 
The Person Merge/Split window displays. The 
highlighted name from the Person List pre-fills in 
the Merged Persons Closed section.  

7 Enter the Person ID of the Merged Forward 
Person. 

8 Click on the Validate button. 
The system checks for an open case and a valid 
Person ID. When the check is complete, the 
Merge button enables. 

9 Click on the Merge button. 
If the person to be closed is in an open stage, the following message displays: 
”The closed person is in open stages. Merge with extreme caution. Continue?” 

10 Click on the Yes button.  
The following message displays: “Merge ID# into ID#?” 
The first ID number listed is for the Merged Closed Person. The second ID 
number is for the Merged Forward Person. NOTE: If you realize that you have 
made a mistake in selecting your persons, click on the No button. The Person 
Merge/Split window remains open until you close it. 

11 Click on the Yes button. 
The Person Forward Selection window displays. 

12 Select information from the Person Forward Selection window by clicking on the 
radio button next to each applicable field. 
The type of information you select—and which person you select it from—affects 
the information that is retained for the Person Forward. 

 

Person Merge Warnings and 
Error Messages: 

When completing a person 
merge, you may see warnings 

and/or error messages. 
Warnings do not prevent you 
from completing a merge, but 

error messages do. 

Reasons for Warnings:  
Both persons must be the same 

sex (if recorded). 

Both people must have a DOB 
that is within 5 years 

(if recorded). 

One of the persons is involved 
in a fatality report. 

Reasons for Error Messages: 
Social Security numbers  

do not match. 
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13 When you have made all of your selections from 
the Person Forward Selection window, click on 
the OK button. 

14 Click on the Yes button to confirm the merge 
process. 
The name of the person logged on and the date 
of the merge displays in the Staff NM Merge 
and Date Merge fields. 

15 Click on the Save button. 
The change is saved in the system and the Person 
Merge/Split window displays. 

16 Click on the Close button. 
The Person List displays. 

17 Click on the Close button to close the Person 
List. 
The Task List displays. 

18 Click on the Close button to close the Task List. 
The Assigned Workload displays. 

 

Person Split 
A Person Split is performed when the records for two separate persons were accidentally merged 
into one. Performing a Person Split reinstates the Person Closed to the database, but it does not 
return the Person Closed to his or her original stages, events or allegations. The records for these 
individuals must be restored carefully for each stage and event. 

After a Person Split is performed, the information for the Person Closed can be accessed through 
the Person Detail window when conducting a Person Search. Person Detail information that 
existed for the Person Closed prior to the merge is restored. The worker must update all 
demographic information and “return” the Person Closed to all appropriate stages and events. 
The worker can use the Maintain Person task to restore the Person Closed to open stages. The 
worker also must remove the Person Forward by performing the Remove Person – Added in 
Error function. (See page 25.) 

A data fix will be run only when requested by a worker. This data fix returns the Person Forward 
to all appropriate stages and events that existed prior to the merge. 

1 On the Assigned Workload, select the stage which contains the person information 
that was merged in error. 
The Tasks… button enables. 

2 Click on the Tasks… button. 
The Task List displays for the selected stage. 

 
Because of the complexity 
involved with restoring this 
information, merges should 

be completed with care. 

 

If you determine that the 
person selected to be merged 

closed should, in fact, 
be merged forward, use the 

Switch function:  

1 Click on the Options menu. 

2 Click on the Switch 
command. 

 

Step-by-Step: 
Splitting a Person Record 
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3 Click on the Maintain Person task. 
4 Click on the List… button. 

The Person List displays for the selected stage. 
5 Click on the name of the person who was merged in error.  
6 Click on the Options menu and select Person Merge/Split. 

The Person Merge/Split window displays. The system pre-fills the person’s name 
into the Merged Persons Closed section. 

7 In the list section at the top of the window, select 
the merge you want to split. 
The system fills the merge information into the 
detail section of the window. 

8 Click on the Split button. 
The following message displays:  
“Split ID# from ID#?” 
The first ID number listed is for the Closed 
Person. The second ID number is for the 
Forward Person. 

9 Click on the Yes button. 
10 Click on the Save button. 

The change is saved in CONNECTIONS. The 
Person List displays.  

11 Click on the Close button to close the Person 
List. 
The Task List displays. 

12 Click on the Close button to close the Task List. 
The Assigned Workload displays. 

 
Historical Person List 
The Historical Person List displays all individuals removed from a specific FAD home because 
they left the home. In order for these individuals to display on the Historical Person List, the 
worker must use the Remove Person – Left Home function (page 24). Individuals who were 
removed from a FAD home because they were Added in Error (via the Remove Person – Added 
in Error function) do not display on the Historical Person List. 

The Options menu on the Person List includes the Historical Person List command, which 
opens the Historical Person List. This window displays all of the individuals removed from a 
specific FAD stage, including the date on which each person was removed. A specific Business 
Function is required to enable this command. 

If a person is involved in a merge, the Historical Person List displays the Person Forward 
information; if the person is involved in a split, the original name displays with the original 
information prior to the merge. 

 

Things to Consider  
Before Splitting: 

The Merged Forward Person 
cannot be deleted from the 
stages that were open at the 
time the Person Merge took 
place. The Merged Closed 

Person’s pre-merge information 
is not “reattached” by 

completing a Split. Follow-up 
demographics and case/stage 
maintenance are necessary to 

complete the process. 
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When an historical record exists for a principal in a FAD home, the following message displays 
on the Person List: “Historical records exist.” 

1 Click on the WORK button. 
The Assigned Workload displays. 

2 Select the FAD stage containing the Historical Person List you would like to 
view. 
The Tasks… button enables. 

3 Click on the Tasks… button. 
The Task List displays. 

4 Click on the Maintain Person task. 
5 Click on the List… button. 

The Person List displays. 
6 Click on the Options menu and select Historical Person List. 

The Historical Person List displays. 
7 Click on the Close button to close the Historical Person List. 

The Person List displays. 
8 Click on the Close button to close the Person List. 

The Tasks List displays. 
7 Click on the Close button to close the Task List. 

The Assigned Workload displays.  
 

Effect of Historical Persons on 
Foster Home Certificates and Approval Letters 
The Remove Person – Left Home function described in the previous section affects the 
historical record of a FAD home, including certificates and approval letters. 

When an individual is removed from a FAD home with the Remove Person – Left Home 
function, the historical certificate or approval letter retains that person’s name in a “frozen” 
historical document. This helps ensure that the historical home certificate or approval letter 
reflects accurate information for the historical period represented by that document. 

Certificates and approval letters generated after an individual has been removed from the FAD 
home via the Remove Person – Left Home function do not show the person as a member of the 
foster home. 

 

 

Step-by-Step: 
Viewing the Historical Person List 
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The F/A Home License Window 
Recording and Modifying Program Types 
The Benefits Issuance Control System (BICS) pays foster homes for the services they provide to 
children placed in their care. BICS is being enhanced to pay Voluntary Agencies based on an 
established rate. The amount of these payments for Voluntary Agency-certified or approved 
foster homes is based on a number of factors, including the Program Type recorded on the F/A 
Home License window in CONNECTIONS. The Program Type reflects the degree of care and 
supervision in the foster home. For this reason, it is imperative that a foster home’s Program 
Type accurately reflects the home’s actual classification. 

The Program Type(s) selected on this window must be compatible with the selected Facility 
Type. If an incompatible Program Type is selected, the following message displays: 

“The Program Type selected is invalid for the setting.” 
 

The following selections are available in the Program Type field on the F/A Home License 
window: 

• Therapeutic 
• Special Needs – Mother/Child 
• Special Needs – Medical 
• Special Needs – Maternity 
• Special Needs – Hard to Place 
• Special Needs – HIV +/ AIDS 
• Special Needs – Behavioral 

• Regular 
• Emergency 
• Cong. Care/FA – Refugee Assistance Program 
• Cong. Care Only – Supervised Independent 

Living Program 
• Cong. Care Only – Sexual Offenders 
• Cong. Care Only – Diagnostic Reception Center 

 
The “MAINTAIN FAD” Business Function must be included in 
a worker’s Business Function Profile (BFP) in order for the 
worker to record information on the F/A Home License 
window. In addition, the worker must be the Primary or 
Secondary worker assigned to the FAD stage, or be a member 
of the Primary or Secondary worker’s unit hierarchy. 

At least one Program Type must be selected for a foster home; 
multiple Program Types may also be selected. If a worker 
attempts to save the F/A Home License window without 
recording a Program Type, the following message displays: 

“You must have at least one program type checked 
in order to save.” 

 

 
Keep in mind that the 

“Emergency” Program Type 
denotes a particular type of 

foster home that is certified to 
accept emergency placements 

on an ongoing basis. 

This is not to be confused with 
a foster home that is in 
“Emergency” Status. 
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Program Authorization Dates 
Four pairs of From and To date fields display at the bottom of the F/A Home License window. 
Each pair of date fields corresponds to one of the BICS non-Congregate Care program type 
groups (Therapeutic, Special Needs, Regular and Emergency). These date fields are required for 
any FAD home with a Setting of “Foster Home” and a Program Type selected from one of 
these four groups. 

These From and To dates are not the same as the certification/approval (or recertification/ 
reapproval) From Date and To Date fields in the upper right corner of the F/A Home License 
window. While the certification/approval From Date and To Date fields reflect the current 
certification/approval period for the foster home (and are system-generated when the 
certification/approval or recertification/reapproval is approved by the supervisor), the Program 
Type group From date fields at the bottom of the window reflect the dates when the foster home 
was authorized to begin operations in accordance with the corresponding Program Type. The 
From type for the applicable Program Type group must be recorded by the worker. 

For example, a foster home began operations as a Therapeutic foster home (and progressed to 
Accepted-Active status for the first time) on April 30, 2001; at that time, the home’s certification 
From Date and To Date would be 4/30/2001 – 4/30/2002. The home was recertified in April 
2002, changing the certification From Date and To Date to 4/30/2002 – 4/30/2003. The 
Therapeutic (Program Type) From field still reads 4/30/2001, because that was the date on 
which the home first began operations as a Therapeutic foster home. Since the Therapeutic 
Program Type has never been deselected, the Therapeutic (Program Type) To field remains 
blank. Recertification/reapproval of a foster home does not change the Program Type From or 
To date fields. 

For many foster homes in CONNECTIONS, the From date for a selected Program Type group 
will be the same as the date the home was certified or approved to provide care. There are, 
however, situations in which a foster home’s program type(s) may change. For example, a home 
may originally have been certified as a Regular foster home on 5/15/2002, but the foster parents 
subsequently meet the regulatory requirements (including specialized training) and receive 
certification to provide Therapeutic foster care services on 10/23/2002. This particular change 
would result in a change in the amount of payment the foster parents would receive from BICS 
for affected children who are placed in the home. This change would be reflected not only in the 
Program Type field, but also in the corresponding Program Type From and To date fields, as 
applicable. 

A BICS program type group is considered selected when at least one of its associated 
CONNECTIONS program types is selected; it is considered deselected if none of its associated 
program types is currently selected. 

When one of these choices is selected in the Program Type field, the corresponding From date 
field highlights in yellow, indicating that it is a required field. 
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If a worker attempts to save the F/A Home License window after selecting an item in the 
Program Type field without recording a corresponding From date, the following message 
displays: 

“Program Type From Date required for selected program type(s).” 
 

Valid program type dates are defined as follows: 

• Both the From date and, if applicable, the To date must be within the past two years. 

• Both the From date and, if applicable, the To date must not be more than six months in 
the future. 

• The To date can never be earlier than the From date. 

If the worker records an invalid date in one of the date fields, one of the following messages 
displays, as applicable: 

“Program Type Dates must be within the past 2 years.” 

“Program Type Dates must not exceed 6 months in the future.” 

“Program Type To Date cannot be less than From Date.” 
 

The From date field does not populate automatically; the worker must record the appropriate 
date in this field on the F/A Home Licensing window. The From field must contain the date the 
foster home is authorized to begin operations. This date cannot be more recent than the To date. 
The To date will always be blank until a particular home’s program ends. (The worker must 
deselect the applicable Program Type and then record the appropriate date in the To field for that 
Program Type group. The To date is never system-generated.) 

When a worker opens the F/A Home License window, if the Program Type field is blank, the 
corresponding From and To date fields will enable when an applicable program type is selected. 
If a valid date is already present when the worker opens the F/A Home License window, the date 
is modifiable regardless of which program type is selected (or if no program type is selected). 

Once a home has been progressed to Accepted-Active status, if a worker deselects a previously 
selected item in the Program Type field and selects another non-Congregate Care program type 
group, the To date must be completed for the deselected program type group. 

If a worker records a program type From date and saves the F/A Home License window, but then 
needs to remove the entry, the worker must deselect the recorded program type, record the same 
value from the From field into the To date field and save the change. Each deselected program 
type group’s From and To fields should contain valid data. 
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If a worker attempts to save the F/A Home License window 
after deselecting an item in the Program Type field without 
recording a corresponding To date, the following message 
displays: 

“Program Type To Date required for 
de-selected program type(s).” 

 

The program type From and To date fields can be modified 
only after the home has progressed to Accepted-Active status at 
least once. 

CONNECTIONS will retain and display all saved Program 
Type From and To dates, regardless of the Program Type that 
is currently selected for the foster home. 

 

Step-by-Step: 
Recording Program Types and 
Corresponding Program Dates 
on the F/A Home License Window 

1 From the Task List for a selected foster home, select 
the Maintain Licensing Information task and click 
on the Detail… button. 
The F/A Home License window displays. 

2 In the Program Type field, double-click to select a 
program type. 
A system edit requires you to select at least one 
program type; multiple program types may be 
selected. The program type(s) you select must be 
appropriate for the Setting and Facility Type 
recorded on the window. 

3 If a Therapeutic, Special Needs, Regular or 
Emergency program type is selected, the 
corresponding From date field highlights in yellow, 
indicating that it is a required field. 

4 Enter a valid date in the applicable From date field. 

5 If the foster home is in any status other than Accepted-Active or Emergency, click on 
the Save button to save the changes to the window. 
 
—OR— 
 
If the home is in Accepted-Active or Emergency status, click on the Save and 
Submit button to save the changes and submit them for supervisory approval. 

 
Note for Supervisors: 

The Program Type From and 
To date fields cannot be viewed 
from the FRS or via a Resource 

search. To view these fields, 
open the F/A Home License 

window from the Event List or 
the Task List. (Both lists can be 

accessed from caseworker’s 
Assigned Workload.) The 

instructions below open the F/A 
Home License window from the 

Assigned Workload: 

1 Open the caseworker’s 
Assigned Workload (via the 
Unit Summary window), 
select the applicable FAD 
stage and open the Task 
List. 

2 Select the Maintain 
Licensing Information task 
and click on the Detail… 
button. 
If the F/A Home Licensing 
window is pending approval, 
the following message 
displays: “Saving will 
invalidate the pending 
approval. Continue in 
modify mode?” 

3 Click on the No button, 
since you only want to view 
(not modify) the information. 
The F/A Home License 
window displays in view-
only mode. 
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Module 2: 
FAD Local Data Maintenance 

The Local Data Maintenance (LDM) function in CONNECTIONS is used to maintain closed 
FAD stages. This is a corrective process only. It is to be used exclusively to correct errors or 
oversights in the original home record. 

By the end of this module, you will be able to: 

• access the LDM window; 

• recognize the components and layout of the LDM window;  

• change person demographics; and 

• access and use the LDM Online Help functions. 
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Local Data Maintenance (LDM) Security 
There are situations in which case information for a closed FAD home needs to be corrected. For 
example, a person’s name, address or other demographic information might have been recorded 
incorrectly. FAD workers can view and update person demographic information in closed FAD 
stages by selecting the Maintain Closed Person Demographics command from the Options 
menu on the Case Summary window. The Maintain Closed Investigation command is not 
available to FAD workers. Maintain Closed Person Demographics can be used to correct 
demographic information due to an error in data entry in the original investigation or due to the 
availability of additional information. 

The LDM window is a single, multi-tabbed window that allows designated workers to view and 
correct information in closed FAD homes. FAD workers can only use this window to correct 
person demographic information. 

Access to the Local Data Maintenance window requires the “MAINT CLSD PERS” Business 
Function. The actions permitted by this Business Function and the method of accessing LDM are 
discussed below. (To view your own Business Function Profile, see “Viewing Your Business 
Function Profile” on page 13 of this guide.) 

Menu Command on 
Case Summary 

Window 
Maintain Closed Person Demographics 

Security Attribute 
Needed Maintain Closed Person Demographics 

Additional Access 
Requirements 

• FAD stage is closed  
and 

• Worker must be from same 
district/agency as primary worker 
when stage was closed 

LDM Tabs Enabled Person Demographics 
 

Accessing the LDM Window 
The LDM window contains four tabs: Person Demographics, Add/Relate Person, Allegations 
and Investigation Conclusions; but only one—the Person Demographics tab—is available to 
FAD workers. 

The LDM window can be accessed through the Case Summary window. Selecting the Maintain 
Closed Person Demographics command opens the LDM window in modify mode. 

Since the case in question is closed, it does not display on the Assigned Workload. Therefore, it 
is necessary to perform a Case Search.  
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Step-by-Step: 
Accessing LDM from the Case Summary Window 

1 Click on the Case button on the CONNECTIONS Toolbar. 
The Case Search Criteria window displays. 

2 Type the Case ID or Case Name into the appropriate fields. 
3 Click on the Search… button. 

The Case List displays with the search results. 
4 Click on the home that is to be viewed or updated. 
5 Click on the Summary button. 

The Case Summary window displays. 
6 Click on the stage to select it. 
7 Click on the Options menu and select the Maintain Closed Person 

Demographics… command. 
The LDM window displays with the Person Demographics tab active. 

8 Click on the Close button to close the LDM window. 
The Case Summary window displays. 

9 Click on the Close button to close the Case Summary window. 
The Case List displays. 

10 Click on the Close button to close the Case List. 
The Case Search Criteria window displays. 

11 Click on the Close button to close the Case Search Criteria window. 
The CONNECTIONS Toolbar displays.  

 

The Layout of the LDM Window 

The LDM window is organized into three sections: 

• Heading 

• Tabs 

• Footer 

The Heading, which is always present when the LDM window is 
open, includes the following information: Case Name, Stage ID, 
Case Status, Case ID, Report Date and Event Status. 

The Footer is always present when the LDM window is open. Only the Close button appears in 
the Footer. Clicking on this button closes the LDM window. In this example, closing the LDM 
window returns you to the Case Summary window. This process also gives you the opportunity 
to save changes to the LDM window. 

 
When the LDM window is 
opened via the Maintain 

Closed Person Demographics 
command on the Case 

Summary window, no events 
are generated and the Event 

Status field is blank. 
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Information recorded on the LDM window is stored in the CONNECTIONS database. When you 
re-open the LDM window, it is “refreshed” with the most current information. This information 
can be reviewed and, if necessary, updated further. 
 

Person Demographics Tab 
The Person Demographics tab is the default tab when LDM is 
accessed. It allows workers to view and correct information 
about persons associated with a closed FAD home. This tab is 
the only active LDM tab for FAD workers. 

The tab is divided into two sections: 

• The upper grid lists all of the persons in the stage. 

• The lower grid contains detailed information about the 
person selected in the upper grid. 

Clicking in a row of the upper grid selects that person for 
modification. An arrow to the left of a row indicates that the 
information in the lower grid applies to that person.  

All columns in the upper grid are modifiable by clicking 
directly in the grid cell and typing, with the following 
exceptions: 

 
You can navigate to the LDM 

from the Person Search window 
as follows: 

1. Select the person from the 
Person Search List by 
clicking on that row of the list. 

2. Click on the Case List button 
on the Person Search 
window. 

3. Select the appropriate case 
on the Case List. 

4. Click on the Summary button 
on the Case List. 

The LDM window can be 
accessed from the Case 

Summary window as described 
on page 37. 
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Column Modified by… 

Person ID  Cannot be modified 
This number is system generated 

Race Race selection box elsewhere on Person Demographics tab 

Ethnicity Ethnicity drop-down and selection box elsewhere on Person 
Demographics tab 

Phone, 
Extn, Type 

Maintain Primary Address/Phone window. Accessed via Address/Phone 
button elsewhere on Person Demographics tab 

Role Automatic (re)calculation when changes to Allegations tab are saved 
 
Updating a person’s date of birth in LDM changes the person’s date of birth in all other stages 
associated with that person. Since a person in open stages cannot be modified, the affected stages 
are all closed stages. 

The Age field cannot be modified if there is an exact date of birth listed in the DOB field. If 
corrected exact date of birth information becomes available, correct the DOB field; the Age field 
updates automatically. If the DOB is marked Approximate (A) or Estimated (E), the Age field 
can be modified. When Age is modified, the DOB is recalculated and updated. If new exact date 
of birth information is recorded, be sure to change the date of birth type in the T column. 

Before changing a person’s name on the Person Demographics tab, a Person Search needs to be 
performed to determine if the new name is known to CONNECTIONS. If the name is known to 
the system, use the Add/Relate Person function, rather than changing the name on the Person 
Demographics tab. 

The Race and Ethnicity of the person selected in the upper grid can be modified using the drop-
down arrow and list boxes in the lower right corner of the tab. 

Field Enabling Modification 
Ethnicity 
(drop-down 
field) 

Enables when a person is 
selected in the upper grid. 

Updates the Ethnicity column in the 
upper grid. This field displays “NR” 
when the Ethnicity column in the 
upper grid reads “Not Reported.” 

Ethnicity 
(list box) 

Enables when a person is 
selected in the upper grid AND 
“Hispanic or Latino Origin” 
displays in the Ethnicity field. 

Click on an origin to select it from the 
list. Multiple origins may be selected. 

Race 
(list box) 

Enables when a person is 
selected in the upper grid. 

Updates the Race column in the upper 
grid. Click on a race to select it from 
the list. Multiple races may be 
selected. If more than one Race is 
selected in this field, the upper grid 
displays “Multiple.” 
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The lower grid displays the following information for each identifier: 

• ID 

• Invalid Flag 

• ID Type 

• ID Number 

• Start Date 

• End Date 

• Comment 
 
 

When a person is selected in the upper grid, the lower grid displays all person identifiers (SSN, 
CIN, etc.) for that person. Each identifier appears in its own row of the lower grid. An arrow to 
the left of the row indicates that identifier is currently selected for editing. New identifiers can be 
added by typing into the bottom-most row of the lower grid, which is marked with an 
asterisk (*). Adding a new row with the same Type as an existing row (that does not have an End 
Date) sets the End Date of that existing row to the current date.  

The information in the lower grid is modifiable as follows: 

Column Modified by… 

ID Invalid Flag 
Can only be marked (using the drop-down arrow that appears when 
you click in the cell); cannot be removed. Marking the flag as 
Invalid will set the end date of that row to the current date. 

ID Type 
Can be selected for new rows using the drop-down arrow that 
appears when you click in the cell. This field cannot be modified for 
existing rows. 

ID Number Can be modified by clicking and typing directly in the grid. Cannot 
be modified in a row for which an End Date is set. 

Start Date Automatically set to the current date when a new ID type is added. 

End Date 
Automatically set to the current date when the ID Invalid Flag is 
selected (marked) or when a new row with the same ID Type is 
added. 

Comments Can be modified by clicking and typing directly in the grid. 
 

Buttons on the Person Demographics Tab 
The Address/Phone button never enables for closed FAD stages, since address information is 
tied to the FAD home license that was issued for the closed home; it therefore cannot be 
changed. 

Clicking on the Save button saves changes made on the Person Demographics tab. This button 
is disabled until changes are made on the tab. The Save button disables after a save until the next 
time changes are made to the tab. 

Clicking on the Close button closes the LDM window and returns the worker to the window from 
which the LDM window was accessed (the Case Summary window). This process also gives the 
worker an opportunity to save any unsaved changes to the LDM window. 
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Clicking on the Cancel button cancels all changes made to the tab since the last save. It is 
disabled until changes are made on the Person Demographics tab. Clicking on the Cancel 
button displays the following message: 

“Your changes will be lost. Continue?” 

• Clicking on the Yes button discards any unsaved changes. 

• Clicking on the No button leaves the changes as they were entered. 
 

 

Step-by-Step: 
Changing Person Demographics in the Upper Grid 

1 Open the LDM window for the selected stage.  
See Steps 1-7 on page 38. 

2 Select the person from the Person List by clicking in the column to the left of the 
Last Name. 
A black arrow indicates the person who has been selected. 

3 Click in the DOB field and update the information located there.  
If the child’s age has been modified to be more than 18 years old for CPS 
Familial/FC-DC cases, or more than 21 years old for IAB cases, the following 
message displays when the Save button is clicked: 
 “Age over <18 or 21> years as of Intake. Continue with Save?” 

4 Click on the Save button. 
The following message displays:  
“Changes have been saved.”  

5 Click on the OK button. 
6 To change ethnicity, click on the drop-down 

arrow for the Ethnicity field and select from the 
resulting list. 
Select either Hispanic or Latino Origin or 
Non-Hispanic or Latino Origin, as appropriate. 

7 To specify categories within Hispanic or Latino 
origin, click on an Origin check box from the list below the Ethnicity field. 
In order to select an origin in this field, “Hispanic or Latino Origin” must display 
in the Ethnicity field. An “X” displays in a specific origin’s check box when it has 
been selected. To clear a selection, click on the check box again to remove the 
“X.” Multiple origins may be selected from the list box. 

8 Click on the Save button to save the changes to the Ethnicity field. 
The following message displays: 
“Changes have been saved.” 

9 Click on the OK button. 
10 In the Race field, click on a race’s check box to select it from the list. 

An “X” displays in the check box when it has been selected. To clear a selection, 

 
The Date of Death and 

Approximate Date of Death 
columns can only be modified if 

a Date of Death already 
appears in the grid for that 

person. 
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click on the check box again to remove the “X.” 
Multiple races may be selected from the list. 

11 Click on the Save button to save the changes to 
the Race field. 
The following message displays: 
“Changes have been saved.”  

12 Click on the OK button. 
13 Click on one of the Language check boxes to 

select a language from the list. 
14 Click on the Save button. 

The following message displays: 
“Changes have been saved.” 

15 When you are finished correcting information on 
the Person Demographics tab, click on the 
Close button. 
The Case Summary window displays.  

16 Click on the Close button to close the Case 
Summary window. 
The Case List displays. 

17 Click on the Close button to close the Case List. 
The Case Search Criteria window displays. 

18 Click on the Close button to close the Case 
Search Criteria window. 
The CONNECTIONS Toolbar displays. 

 

 

Step-by-Step: 
Changing Person Demographics in the Lower Grid 

1 Open the LDM window for the selected stage. 
See “Accessing the LDM Window” on page 37. 

2 Select the person from the Person List by clicking in the column to the left of the 
Last Name.  
A black arrow indicates the person who has been selected. 

3 Click on the drop-down arrow in the INV column and select No. 
This indicates that the person identifier is not invalid. (Selecting Yes indicates 
that it is invalid.) 

4 Click on the drop-down arrow in the Type column and select the appropriate 
identifier from the resulting list. 

5 Click in the Number column and record the identifier number. 

 

A person’s information on this 
tab cannot be modified if that 
person is associated with any 

open, non-ARI stage. 
Attempting to modify information 
for a person in an open non-ARI 

stage results in the  
following message: 

 “Can’t modify demographic 
information of people in open 

stages. Person member of 
Stage ID:###” 

Correcting demographic 
information for a person who is 
associated with an open stage 

can only be done on the Person 
Detail window, not through the 

LDM window. Conduct a person 
search to determine if the 

person in question is associated 
with any open stages and 
contact the primary worker 

associated with the open stage 
to discuss any changes. 
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6 Click on the Save button. 
The following message displays  
“Changes have been saved.” 

7 Click on the OK button. 
8 Click on the Close button to close the LDM 

window. 
The Case Summary window displays. 

9 Click on the Close button to close the Case 
Summary window. 
The Case List displays. 

10 Click on the Close button to close the Case List. 
The Case Search Criteria displays. 

11 Click on the Close button. 
 

LDM Online Help 
CONNECTIONS provides an extensive Help program, which contains information on all 
functions of LDM, as well as policy and procedure guidelines, 
law and definitions. Context-sensitive help information is 
available for all elements of the LDM window, including tabs, 
grids, buttons and individual fields. Click on an element to make 
it “active” and press the F1 key on your keyboard to display 
information about that LDM element. 

LDM Online Help includes the following features: 

• A Table of Contents allowing access to all Help information 

• Index and Search functions providing alternate means of finding information 

• Interactive graphic examples of LDM window elements (clicking on certain 
portions of a graphic within LDM Online Help displays explanations of that 
element) 

• Hyperlinks that display related information, such as definitions and procedural 
guidelines 

Pressing the F1 key opens the LDM Help system. Information specific to the LDM window 
element that was active when the F1 key was pressed will display. Once in the Help system, the 
Table of Contents allows access to Help information on other elements of the LDM window. 

 
You must save (by clicking on 

the Save button) after each 
change you make to the Person 
Demographics tab in order for 
that change to be stored in the 

CONNECTIONS database. 
Therefore, if more than one 

change has been made, only 
the last one, if unsaved, is 

discarded when the No button 
is clicked. 

 

The F1 key does not activate 
LDM Help when you are viewing 

the Investigation Conclusion 
narrative. 
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Besides context-sensitive Help information on LDM window elements such as fields, tabs and 
buttons, the LDM Help system includes the following: 

LDM Overview  
A high level summary of LDM, including a listing of its features and functions. This 
overview can be accessed directly by clicking on the Help menu in the upper left 
corner of the LDM window and selecting the LDM Help command. 

“How Do I?”  
Information about how to navigate within the LDM window and how to use its 
functions effectively. 

Glossary 
Definitions of terms commonly used in casework as well as definitions of LDM 
window elements and concepts. 

Guidelines 
Background on the legal, policy and procedural guidelines followed by workers as 
they develop and record information in the LDM window. 

Help on Help 
Instructions for using the LDM Online Help system. 

Key elements of the information in this Step-by-Step Guide relating to features and functionality 
of the LDM window can also be found in the LDM Online Help. 

 

Step-by-Step: 
Accessing LDM Online Help 

1 Click on the CASE button on the CONNECTIONS Toolbar. 
The Case Search Criteria window displays. 

2 Type the Case ID or Case Name in the appropriate fields. 
3 Click on the Search button. 

The Case List displays.  
4 Click on the case to be viewed/updated. 
5 Click on the Summary button. 

The Case Summary window displays. 
6 Click to select the closed FAD home to be viewed or updated. 
7 Click on the Options menu and select Maintain Closed Person Demographics. 

The LDM window opens with the Person Demographics tab displayed. 
8 Click in any field on the Person Demographics tab to make it active. 
9 Press the F1 key on the keyboard. 

LDM Online Help information displays for the selected field. 
10 Click on the Contents tab and click on any of the items listed. 
11 Click on the Close button to close the topic. 
12 Click on the Index tab and click on any item listed. 
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13 Click on the Close button to close the topic. 
14 Click on the Search tab and enter search criteria. 

Review the results displayed. 
15 Click on the Close button. 

The LDM window displays. 
 




